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Document Overview

About this documentation

The documentation for SoftWindows for Unix is provided in two guides:

• This SoftWindows for Unix User’s Guide provides the information you need to use
SoftWindows on your Unix workstation.

• A separate SoftWindows for Unix Administrator’s Guide describes how to install
SoftWindows, and configure it to take advantage of specific features of your Unix
installation. It is designed for use by advanced users, and assumes familiarity with
Unix.

There are two ways to access the SoftWindows Guides:

• You can find both of these guides online. To access them:

1. Choose Online Books from the Help toolchest.

2. In the InfoSearch browser, click SGI_EndUser.

3. Click the title of the book you want to view.

• For quick access to online help, use the Help pull-down menu from the
SoftWindows application window. The Help menu does not represent the full
SoftWindows Guide contents, but is a convenient way to get help on many
commonly sought-for topics.

About this guide

The SoftWindows 95 User’s Guide consists of the following chapters. Click on the Chapter
Title to go there.

• Chapter 1, “Introduction”—Describes the main features of SoftWindows and
explains how it enables you to run PC applications on your Unix workstation.
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• Chapter 2, “Using SoftWindows”—Explains how to run SoftWindows, describes
the key features of the SoftWindows window, and explains how to use floppy disks
and the keyboard with SoftWindows.

• Chapter 3, “Using Windows 95”—Explains how to run Windows 95, and gives a
brief introduction to its features with a simple tutorial to help you become familiar
with using it.

• Chapter 4, “Using MS-DOS”—Explains how to run MS-DOS, use MS-DOS
commands, use the MS-DOS editor, and install and run MS-DOS applications.

• Chapter 5, “Troubleshooting”—Provides answers to commonly asked questions
and suggests solutions to the problems that you may encounter while running PC
applications on your Unix workstation. It also gives explanations of the
SoftWindows, MS-DOS, and Windows errors.

• Glossary—Describes the technical terms used in the guide.

Conventions

For clarity, this guide uses the following conventions:

• Linked references to other sections in the book are colored blue.

• Steps in a procedure are numbered.

Abbreviations

This guide uses the following abbreviations:

• "SoftWindows" refers to SoftWindows95 for Unix workstations

• "Insignia" refers to Insignia Solutions

• "MS-DOS" refers to Microsoft Disk Operating System for the IBM PC

• "PC" refers to an Intel-based computer

• "Windows" refers to Microsoft Windows95
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Chapter 1

1. Introduction

This chapter describes the main features of SoftWindows, and explains how it enables
you to run PC applications on your Unix workstation.

What is SoftWindows?

SoftWindows is a complete IBM-compatible PC in software. It allows you to run
Windows 95 and MS-DOS applications on your Unix workstation as if they were running
on a PC.

It combines full PC compatibility with fast performance and built-in networking, so, for
example, you can receive electronic mail, read PC-formatted CD-ROMs, and print PC
files to a network printer, all from your Unix workstation.

SoftWindows: a cross-platform solution

SoftWindows is available for the leading RISC-based Unix  workstations from
Hewlett-Packard, Sun/SPARC, IBM, Silicon Graphics, and Digital, as well as Apple’s
Power Macintosh and Macintosh computers.

SoftWindows provides integrated access to information throughout an organization by
letting PC users and Unix users share the same data and applications. From one
workstation users can run native Unix applications, Windows and MS-DOS applications,
and also use PC-based networked systems.

SoftWindows allows you to standardize on today’s popular productivity applications,
such as Microsoft Office and Lotus SmartSuite on PC, Unix, and Macintosh platforms,
throughout the organization.



2

Chapter 1: Introduction

80486 processor emulation

SoftWindows 95 provides full emulation of the Intel 80486 processor, enabling you to
exploit the full functionality of current PC software.

Among the features provided by this emulation are:

• The ability to run Windows 95

• Continued support for OLE 2.0

• Multiple MS-DOS sessions

• 32-bit memory addressing

• Support for virtual device drivers

The Windows 95 desktop

SoftWindows includes color and monochrome Windows display drivers to optimize the
performance of Windows 95 and allow it to be run in a window of any size on either color
or monochrome displays. The Windows desktop can be resized dynamically, without
restarting.

You can switch between a PC application and another Unix application at any time. You
can copy and paste text or graphics between PC and Unix applications. Text or graphics
can be cut or copied from Windows applications, and is automatically converted into the
appropriate format when you paste it into a Unix application.

Windows 95 TurboStart

A unique Insignia TurboStart™ feature lets you quit from SoftWindows without exiting
Windows 95. Windows loads instantly the next time you run SoftWindows, and you can
resume where you left off.

The SoftWindows MS-DOS window

When running MS-DOS, SoftWindows emulates the main color and monochrome PC
display types: SVGA and Hercules.
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Indicators in a status bar at the bottom of the SoftWindows window show you whether
special keyboard modes or certain configuration options are selected.

The SoftWindows  menus

The SoftWindows menus allow you to configure SoftWindows  to suit your PC
applications. Many operations that would require hardware or board changes on a real
PC can be carried out simply by choosing the appropriate function from one of the
SoftWindows menus.

Product specification

SoftWindows 95 emulates a PC to provide the following features:

Processor

Emulated 80486 (real, protected, and virtual-8086 mode). Emulated 80487 math
co-processor using the host computer’s math co-processor.

Memory

PC memory up to 32 Mbytes.

Video

In Windows 95 applications, a SoftWindows display driver is used to pass graphics calls
directly to X Windows. This takes full advantage of the host graphics speed and display
resolution, up to and beyond resolutions achievable with SVGA graphics. In MS-DOS
applications SoftWindows provides SVGA graphics.
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Keyboard

The host keyboard is used. SoftWindows 95 provides an emulated IBM 101-key
keyboard that maps to the host keyboard, as well as optional support for additional
keyboards.

Mouse

The host mouse is used. SoftWindows’ own mouse driver allows the mouse to move
between the PC and host windows acting as expected in both environments.

Hard disks

SoftWindows uses two Unix files as the PC’s C: and (optionally) D: drives. Each drive can
be configured to be up to 300 Mbytes.

FSA and VFSA

In DOS, Unix directories can be used for network drives E: through Z: using the
SoftWindows File Sharing Architecture (FSA). FSA allows PC software to access Unix
files and vice versa.

In Windows95 and at the DOS prompt, FSA  is referred to as  VFSA because it contains
long file name support.

Floppy Disk Drives

Drives A: and B: are supported using the host’s 3.5-inch drive.

Sound and video

SoftWindows 95 includes drivers to allow wav sound files and avi video files to be played
from Windows, using the workstation hardware. SoftWindows 95 also supports MIDI
input and output.
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Serial Port

Four communications ports are supported (COM1, COM2, COM3, and COM4) with
selectable baud rate, parity, and word format. The serial port on the host is used as a
communications port.

Parallel Ports

Three standard PC printer ports are supported: LPT1, LPT2, and LPT3.

CD-ROM

A CD-ROM driver allows PC-format CD-ROMs to be read from within SoftWindows.
The Microsoft CD-ROM extensions are included.

Networking support

SoftWindows includes a set of ODI-compliant network drivers and can take advantage
of your Unix Ethernet connection to access other PCs on your network.

SoftWindows includes Novell NetWare and LAN Manager client software. In addition,
it supports most other network packages including Windows for Workgroups, Winsock
(Mosiac and Netscape), Banyan VINES, DEC PATHWORKS, LANtastic, and TCP/IP
packages such as Novell’s LAN WorkPlace. You can also access Windows NT servers
using standard LAN Manager software.
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Technical specification

The following table details the SoftWindows 95 specification.

Table 1-1 SoftWindows95 Specification

Feature Specification

Processor 80486 CPU – Protected, Real, and
Virtual-8086 modes

Math processor 487 Floating Point Unit

ROM BIOS PC/AT-compatible

Memory 1 Mbyte to 32 Mbytes

Floppy disk drives Two drives, A: and B:

Hard disk drives Two drives, C: and D:

FSA drives E: to Z:

CD-ROM Data on drive F:

Networking Ethernet drivers

Video Super Video Graphics Array (Video 7) or
Hercules. SVGA modes supported: 40h
to 45h, and 60h to 69h except 63h and 64h

Parallel ports Three ports, LPT1:, LPT2:, and LPT3:

Serial ports Four ports, COM1:, COM2:, COM3:, and
COM4:

Keyboard PC/AT 101/2-key keyboard

Mouse Microsoft Bus Mouse compatible

Microsoft Windows Windows 95

SoftWindows driver Color and monochrome displays, and
mouse
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2. Using SoftWindows

This chapter describes how to run SoftWindows, and how to use it to run Windows &
MS-DOS applications on your Unix workstation.

SoftWindows initially runs in a separate X Windows window, and you can run PC
applications at the same time as your Unix applications.

SoftWindows is set up to launch Windows 95 automatically. Run MS-DOS in a window,
or exit Windows 95 to MS-DOS.

Running Windows

There are two ways to run Windows 95:

• Type SoftWindows95 or swin in a Unix shell.

• Double-click the SoftWindows 95 icon.

The first time you run SoftWindows a dialog box will be displayed to allow you to choose
the size of the Windows desktop. Select the size you want, then choose OK to run
Windows.

Note: Increasing the size of the window will require more memory and may reduce
performance.

The Windows 95 desktop will then be displayed. For more information about the
Windows desktop refer to Chapter 3, “Using Windows 95”.
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Restarting and quitting SoftWindows

To restart SoftWindows

1. Choose Restart… from the Actions menu.

A dialog box warns you that work can be lost if you have not saved files before
restarting.

2. Click OK to restart.

Note: Holding down the Ctrl-Alt-Delete keys produces an immediate restart without the
warning.

To freeze SoftWindows

If you are switching between SoftWindows and Unix applications, you can either
manually freeze SoftWindows or set SoftWindows to automatically freeze when it loses
window focus. This lets you optimize your use of the available CPU resources on your
system.

• Choose Freeze from the Actions menu.

• A checkmark appears next to the Freeze menu item to let you know Freeze is
selected.

When you choose Freeze, you will not be able to use MS-DOS or Windows. You can still
reposition the SoftWindows window on your desktop, and the SoftWindows menu items
File, and Actions are still available.

• Select Freeze again from the Actions menu to resume your MS-DOS or Windows
session.

• The checkmark disappears next to the Freeze menu item when Freeze is not active.

If you want SoftWindows to freeze automatically whenever its window does not have
focus, choose Auto Freeze from the Options menu. SoftWindows will unfreeze as soon
as focus is returned to its window.

Note: You should not use Freeze or Auto Freeze if you are using network resources or
are connected to a LAN server, as any network connections could time out.
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To exit from SoftWindows

When you use the following method to exit SoftWindows, you are effectively putting
SoftWindows to sleep; this means that any Windows applications you may be running
won’t be exited. If you want to shutdown SoftWindows completely (and exit any
currently running Windows applications), follow the steps in “To shutdown
SoftWindows.”

1. Choose Exit from the File menu.

A dialog box appears.

2. Make sure the Create TurboStart™ data file option is selected (check should appear in
the box) and then click OK.

This saves your work so that Windows 95 loads instantly the next time you run
SoftWindows, and you can resume where you left off.

Caution: If you don’t select the Create Turbostart data file option and you have
Windows applications running, you may damage your Windows application files.

Save Configuration Changes is selected by default. This saves any changes you have
made to the configuration of SoftWindows in your .swinconfig file.

If you do not want to save any changes, click Save Configuration Changes to deselect
it before clicking OK. For more information refer to “SoftWindows configuration” in
the SoftWindows95 for Unix Administrator’s Guide.

To shutdown SoftWindows

Follow these steps to shutdown SoftWindows, exiting any open Windows applications.

1. Click the Start button and choose Shut Down.

A dialog box appears with several options, presented as questions:

• “Shutdown the computer?” quits SoftWindows; it does not shutdown your
workstation.

• “Restart the computer?” restarts SoftWindows; it does not restart your
workstation.

• “Restart the computer in MS-DOS mode?” restarts SoftWindows and displays a
window with an MS-DOS prompt.



10

Chapter 2: Using SoftWindows

The SoftWindows graphical user interface is not available in the MS-DOS mode;
see “To exit from MS-DOS” for instructions about exiting from this mode.

• “Close all programs and log on as a different user?” exits your current
SoftWindows session and lets you log on to SoftWindows as another user.

2. Select an option and click Yes.

To exit from MS-DOS

Type EXITSWIN at the MS-DOS prompt.

This exits from SoftWindows immediately, without saving any changes to your
SoftWindows configuration.

Using the keyboard

The illustration provided below shows the layout and keycap engravings of the US
PC/AT keyboard. This is SoftWindows’s default keyboard emulation.

Figure 2-1 SoftWindows Default Keyboard Layout
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Using floppy disks

SoftWindows lets you work with 3.5-inch MS-DOS format floppy disks using the floppy
disk drives on your Unix workstation. While the application is running, the A: drive is
dedicated to SoftWindows. If you want to use the diskette drive from IRIX, simply
deactivate the A: drive from the SoftWindows Activate menu.

To use a floppy disk

1. Insert the disk into the workstation’s floppy disk drive.

2. Attach the disk by choosing Attach Floppy A (or Attach Floppy B) from the Actions
menu, depending on whether you have assigned drive A: or B: to the floppy disk
drive.

A: (or B:) appears in the SoftWindows status bar indicating that the drive is attached
and that you can now access the disk from SoftWindows.

For example, to see the contents of the disk, type DIR A: or DIR B: at the MS-DOS
prompt.

To show the files on a floppy disk from Windows 95

Double-click the [A:] floppy disk icon in the My Computer folder.

To show the files on a floppy disk from MS-DOS

Type DIR A: at the MS-DOS prompt.

To eject a floppy disk

Choose Eject Floppy A: or Eject Floppy B: from the Actions menu.

To format a floppy disk

Use the FORMAT command. See “FORMAT” in Chapter 4.
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Using CD-ROMs

SoftWindows automatically configures itself to recognize your CD-ROM drive, if any; no
additional setup is required. To access the drive, double-click the My Computer icon.
Double-click the CD-ROM icon (labeled drive D: or E:).

To eject a CD-ROM

To eject a CD-ROM, double-click the My Computer icon. Click on the CD-ROM icon
using the right-mouse button and choose Eject from the menu.

Using PC files stored in Unix

SoftWindows includes software called the File Sharing Architecture (FSA) that allows PC
files to be stored in the Unix file system and still be accessed by MS-DOS and Windows
applications as though they were on a PC disk.

If you were using a PC, the FSA drive would be on another computer and the PC would
be able to access it through a network driver. SoftWindows uses this attribute of
Windows 95 to access a specified Unix directory, which can either be on your
workstation’s hard disk or on an NFS-mounted file system from a remote server.

The PC files in an FSA drive reside as individual Unix files and can be used by Unix
programs that can work with PC files.

In addition to FSA, SoftWindows provides VFSA, which supports FSA in Windows95
(although net use will not work in DOS box). VFSA contains long filename (in other
words, not 8.3) support.

PC Filenames

Not all Unix filenames are valid as PC filenames. You should adhere to the PC filename
conventions when creating files in the Unix file system that you will want to access from
SoftWindows.

• PC filenames have the form:

name.ext
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• Filenames can include the letters A–Z, the digits 0–9, and the following symbols:

_ ! # $ % & @ ^ ~

However, all of these characters except _ (underscore) are special characters in Unix,
so it is recommended that you avoid them in filenames.

• Upper and lower case letters are considered equivalent. Unix filenames should
usually use all lower case, because the files named with lowercase letters are given
priority when a conflict occurs. You can configure SoftWindows so that the priority
is given to upper case; refer to the SoftWindows95 for Unix Administrator’s Guide.

• When accessing Unix files using an FSA drive, a Unix filename that does not adhere
to the above restrictions is converted to a legal name, although it may not be
accessible to Windows and MS-DOS if another file of the same name already exists.

For example, if you list the files in your Unix home directory, the file .profile will be
given the name PROFILE.5AV.

To save a PC file to Unix

In SoftWindows, copy the file to a drive which has been set up as an FSA drive.

For example, if you have set up your home directory as drive E:, save the file to the E:
drive. You will then see the file in your home directory.

To copy a Unix file to SoftWindows

Put the file in a directory you have set up as an FSA drive.

For example, if you have set up your home directory as drive E:, you can make a file
available on the PC drive E: by putting it in that directory.

To list the Unix directories setup as PC drives

Type NET USE at the MS-DOS prompt.

This will list the drive letter of each FSA drive followed by the Unix pathname of the
directory to which it is attached.

Note: The not sharing message is normal, and refers to MS-DOS SHARE.
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When SoftWindows is first installed, the following drives are set up for you:

Connecting to a PC network

SoftWindows includes Insignia’s SoftNode networking software to enable you to access
PC network file servers from SoftWindows running on a Unix workstation.

You, or your system administrator must set up networking access. After network access
is set up, you have the same access to a PC file server as a PC user, including the ability
to run multi-user PC applications.

For more information on setting up network access using SoftNode, refer to the
SoftWindows95 Administrator’s Guide.

Using sound

The Sound panel lets you make changes to the sound settings in SoftWindows. To open
the Sound panel, choose Sound from the Options menu. See the following sections for
information about setting specific options in the Sound panel.

Using MIDI

SoftWindows 95 supports both MIDI input and output. You can use any external MIDI
device, such as a keyboard, for MIDI input and output in SoftWindows.

Before being able to use a MIDI device with SoftWindows, you must first configure the
device for your SGI workstation. You can use the “Add a Serial Device” interactive guide,
available in the System Manager, to configure a MIDI device. See “Setting Up Serial
Peripherals” in the Personal System Administration Guide for more information.

Table 2-1 Automatically Installed Drives

Drive Unix directory

E: Your home directory

H: Your home directory
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Use the Device Type pop-up menu in the Sound panel to choose a MIDI device for
SoftWindows. You have three choices:

• Internal specifies the SGI Software Synth program.

• External specifies an external MIDI device connected to a serial port on your
workstation. By default, Serial Port 1 is specified.

You can specify a different serial port in the Value Assigned field, depending on
where your MIDI device is connected. To view the MIDI devices available on your
system, including the serial ports they’re connected to, open the Serial Device
Manager, available in the System Manager.

• None specifies that no MIDI device be selected; this “silences” MIDI and avoids
using the CPU unnecessarily.

An error message appears if you select a MIDI device that isn’t available on your
workstation. For example, an error message appears if you select the Internal MIDI
device and the midisynth program isn’t running. You can view a list of the MIDI devices
configured for your workstation by opening the Serial Device Manager (available in the
System Manager) or by entering startmidi at a command prompt in a Unix shell
window. See the startmidi reference page for more information.

Note: Any Windows application that supports recording from a MIDI device will work
with the SoftWindows MIDI input driver. Make sure that you select “SoftWindows
MIDI” as the input source for recording in the Windows application.

Enabling/disabling sound

To enable or disable sound, click the box labeled “Enable Sound” in the Sound panel.
(Choose Sound from the Options menu to open the Sound panel.) A checkmark appears
in the box when the sound is enabled.

Note: Enabling or disabling sound using the Sound panel does not affect other sounds
produced by Windows applications. To disable sound completely in SoftWindows, you
can either turn down the volume or select “Mute” in the Master Volume panel. (To
display the panel, click the Sound icon in the bottom right-hand corner of the
SoftWindows window, click the right mouse button, and choose Volume Controls from
the menu that appears.)
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Enabling/disabling FPU emulation

Use the FPU Emulation function to select the SoftWindows emulation of the PC Floating
Point Unit. By default, FPU Emulation comes enabled.

• Choose FPU Emulation from the Options menu.

When FPU emulation is enabled, a checkmark is shown beside the menu function.

• Choose FPU Emulation again to disable it.

When you attempt to enable or disable FPU Emulation, a dialog box appears and tells
you that you need to restart SoftWindows. Click OK to implement your changes and
restart SoftWindows.

Note: Due to the different precisions of the PC FPU and the emulated FPU, some
programs may run differently than a PC when FPU emulation is enabled. For example,
the rounding of decimal numbers may be incorrect. In such cases the FPU emulation
should be disabled.

Activating and deactivating drives and ports

Use the Activate function to control which of the PC drives, A: to D:, or the PC ports, LPT1:
to LPT3:, or COM1: to COM4:, are reserved for use by SoftWindows. When you deactivate a
drive, it returns the control to the IRIX desktop.

SoftWindows will always try to activate a drive or port when it is first selected, according
to the settings in the Open Disk Drives, Comms Ports, and Printer Ports dialog boxes;
refer to the SoftWindows95 for Unix Administrator’s Guide, and “Printing, input, and
output” on page 17.

To see which devices are in use by SoftWindows

Choose Activate from the Actions menu.

• Devices in use by SoftWindows are shown with checkmarks next to their names in
the rollover or “cascade” menu.

• Entries with no device assigned to them are shown grayed out in the menu.
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To free a device so that another Unix application can use it

Choose the corresponding drive or port from the Activate rollover menu.

To set read-only access on hard disk drives

Choose C Drive or D Drive from the Activate rollover menu.

• When a button is shown beside the drive name, you have read and write access, and
other users only have read access.

• When there is no button beside the drive name, you only have read access, allowing
another user to write to the drive.

• Any number of users can have read access to a hard disk file, but only one can have
write access at any time.

Printing, input, and output

On a PC, applications communicate with external devices such as printers, modems, and
data loggers via the COM1: to COM4: serial ports and the LPT1: to LPT3: parallel ports.

You can assign these ports to take advantage of the equivalent capabilities of the Unix
workstation.

The following table summarizes the default options for the COM and LPT ports:

*Output must be flushed.

Table 2-2 Default Options for the COM and LPT Ports

Option Description

File Output redirected to a specified Unix
file*

Pipe Output directed to the print spooler for
network printing*

Device Input/output to a device connected to
the workstation’s serial port

None No device assigned
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After outputting from a SoftWindows COM or LPT port to a file or pipe, you need to flush
the output to ensure that the last partial buffer of data is sent to the file or pipe.

SoftWindows provides an Auto Flush option, which flushes the buffer automatically at
specified interval after the last activity on the port.

Alternatively, you can flush output from a port manually when you know that output
has finished.

To flush output automatically

1. Choose Auto Flush… from the Options menu.

Figure 2-2 The Auto Flush Dialog Box

2. Check that the Enable Automatic Flushing box is selected.

3. Set the required delay by moving the Autoflush Delay slider until the field shows the
value you want. You can set any autoflush delay from 1 to 300 seconds.

4. Click OK to save your setting for Auto Flush.

The ideal autoflush delay depends on how quickly the PC application outputs data. You
may need to experiment by starting with a high value, and then reduce it to find the best
setting.

You can set flushing for an individual file or pipe by setting the Enable Windows PostScript
flushing option in the Printer Ports or Comms Ports dialog box.
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To flush output manually

1. Choose Flush Ports from the Actions menu.

A rollover menu appears and lets you select which ports to flush.

2. Choose All to flush all ports, or choose the port you want to flush.

The port should be flushed after outputting to a COM or LPT port from SoftWindows with
the Pipe option.

The buffers are also flushed automatically when you quit from SoftWindows.

Redirecting to a file and piping to a process

You can redirect all output from a specified port to a file in the Unix file system.

To redirect output to a file

Redirecting output from SoftWindows to a file is a useful way of debugging problems
with printing. The file can then be printed externally to SoftWindows.

1. Choose Printer Ports… or Comms Ports… from the COM/LPT Ports rollover menu on
the Options menu, depending on whether you want to redirect an LPT or COM port.

2. Choose File from the popup menu next to the port you want to redirect.
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Figure 2-3 The Printer Ports Dialog Box with Redirect File Setting

The filename defaults to SoftWin.tmp in your home directory. Alternatively, enter the
filename you want to use. If the file already exists, the output will be appended to it.

3. Check that Enable Automatic Flushing is set in the Auto Flush dialog box, so that
output is flushed to the file; refer to the section “To flush output automatically.”

To pipe to a Unix process

You can pipe the output from a port to a Unix process that will accept text input. One use
for this is to print a file which is not PostScript.

1. Choose Printer Ports… or Comms Ports… from the COM/LPT Ports rollover menu on
the Options menu, depending on whether you want to pipe the output from an LPT
or COM port.

2. Choose Pipe from the popup menu next to the port whose output you want to pipe.

3. Enter the name of the UNIX process in the Value Assigned field.



Serial input and output

21

Figure 2-4 The Printer Ports Dialog Box with Pipe to a Unix Process Setting

Do not include the leading pipe symbol, |, as this is assumed. By default, output is
piped to lp, the Unix print spooler.

4. Check that Enable Automatic Flushing is set in the Auto Flush dialog box, so that
output is flushed to the pipe; refer to  “To flush output automatically.”

Serial input and output

A COM port can be attached to either of the serial ports for input and output, with
selectable serial parameters, using the Device option.

This option is intended for use by communications packages that provide their own
handshaking.

The following serial parameters are supported:

Baud rate: 50, 75, 110, 134.5, 150, 300, 600, 1200, 1800, 2400, 4800, and 9600.
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The following combinations are supported:

By default, COM1: is set up by the following MODE command in the AUTOEXEC.BAT file:

MODE COM1:9600,N,8,1

This gives the following communications settings:

9600 baud, no parity, 8 data bits, and 1 stop bit.

This setting can be changed with the MODE command.

To use serial input and output

1. Connect the serial device to the workstation’s serial port.

2. Choose Comms Ports… from the COM/LPT Ports rollover menu on the Options
menu.

The Comms Ports dialog box appears.

3. Choose Device from the COM1: popup menu.

Table 2-3 Combinations for Serial Input and Output

Data bits Parity Stop bits

8 None 1

7 Even 1

7 None 2

7 Odd 1
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Figure 2-5 The Comms Ports Dialog Box

You should enter the appropriate device name for the port you want to use. If
necessary, ask your system administrator.

4. If the serial device needs flow control, select Flow Control.

Serial port emulation

SoftWindows uses facilities provided by the Unix terminal device drivers to determine
the state of the serial port. As a result, the PC/AT serial port cannot be fully emulated,
although most devices and packages designed to operate with it will work equally well
on SoftWindows.

The following technical details are provided for users who need specialized help in
getting a device or package to work properly or who are developing software which uses
the serial ports.

DSR (Data Set Ready)

This line is always held high.

The effect is that devices can detect DTR (Data Terminal Ready), but a response from the
device via DSR cannot be detected by SoftWindows. Therefore SoftWindows cannot
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support hardware handshaking, and XON/XOFF software handshaking should be used
instead.

RI (Ring Indicator)

This modem input signal cannot be detected and is forced off by the software.

Input errors

The occurrence of input overrun and framing errors in the hardware or an input break
condition cannot be detected.

Recommendations

The following should be noted if you are choosing a package to run under SoftWindows
on the Unix workstation or you are developing software that uses the serial ports for
communication.

• You should normally use 9600 baud or lower. Higher speeds are likely to be less
reliable.

• The packet size should be kept small: 512 to 1024 bytes is a suitable size.

• Interrupt driven is preferable to polled data transfer. When SoftWindows receives
data from an external source with XON/XOFF data flow control, the program
running on SoftWindows may have problems. This is due to host buffering of input
data preventing the program from responding quickly enough to XOFF signals.

Input errors

Input overrun and framing errors in the hardware, or an input break condition, cannot
be detected.

Communications problems

If persistent difficulty is experienced establishing a communications link (either no
communication or SoftWindows error dialog boxes), it may be necessary to modify the
cables used. At the RS6000 end of the cable, pin 20 (DTR) should be strapped to pin 8
(DCD) and line 8 of the cable should be cut. See your System Administrator for help.
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3. Using Windows 95

This chapter explains how to run Windows 95, and gives information about working
with Windows 95 and running Windows applications.

It includes a short tutorial to introduce you to the procedures for working with Windows
95.

Running Windows 95

Windows 95 starts in seconds with TurboStart, and you can resume your work where
you left off when you quit.

To use the mouse

As you move the Unix mouse pointer onto the SoftWindows window it automatically
changes to the Windows mouse pointer, so that you can switch freely between Windows
and Unix applications.

To improve performance the Windows mouse pointer is slightly reduced in size.

If you use DOS in full screen mode, you must attach the mouse in the application if you
want to use the mouse to edit.

If you run the application through a DOS prompt in Windows95, the mouse is
automatically attached to the application; there is no need to attach manually.
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To display the SoftWindows MS-DOS window from Windows 95

Click the Start button, choose Programs, and then choose MS-DOS Prompt.

To exit from Windows 95 to the SoftWindows MS-DOS window

1. Click the Start button and choose Shut Down….

A dialog box appears.

2. Select Restart the computer in MS-DOS mode.

3. Click Yes to proceed.

To exit from Windows 95

The recommended way to quit from Windows 95 is to use TurboStart.

However, if you specifically want to exit from Windows 95 proceed as follows:

1. Click the Start button, and  choose Shut Down….

A dialog box appears.

2.  Click Yes to choose the first option and shut down Windows 95. SoftWindows will
then automatically exit.

Tutorial

This tutorial is designed to help you become familiar with using SoftWindows by
installing and running a typical Windows application and printing from Windows.

The tutorial is based on the award-winning Windows program WinPost, which is
supplied with your SoftWindows package. WinPost lets you create simple reminders
which you can leave on your Windows desktop. It is a PC shareware application—if you
like WinPost and decide to continue using it, please send the author the registration fee
as described in its on-line manual.

Most Windows 95 applications are installed by running a standard Windows setup
procedure.
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The installer and its associated files are supplied in the C:\WNPST directory.

1. Run Setup

■ Click the Start button on the taskbar, and choose Run.

■ In the Run dialog box, type C:\WNPST\SETUP

■  Click OK to run the Setup program.

2. Specify where to install WinPost

■ The dialog box allows you to specify the directory into which WinPost should
be installed:

■ Click OK to install in the WINPOST directory on your SoftWindows hard disk file.
The files are then copied to the directory you specified.

3. Finish the installation.

■ A dialog box informs you when the installation is complete:

■ Click OK to return to the Program Manager.

The installation creates a new WinPost group in the Program Manager, containing three
icons:

• WinPost 3.2 is the WinPost application.

• WinPost Manual provides documentation for WinPost. Double-click the icon to
display the document so that you can read it or print it out.

• Read Me! is a document which gives additional information about WinPost.

Figure 3-1 The WinPost Program Group Icons
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When you install a Windows application, the installer usually creates icons for the
application and for any other programs or documents you might need to use with it.
Often these are put in a separate folder.

See “Using Windows” in Chapter 5 for more information about the components of
Windows.

4. Run WinPost

■ Double-click the WinPost 3.2 icon.

The first time you run WinPost, a shareware registration notice is displayed
informing you that you can evaluate WinPost for 21 days.

■ Click OK to dismiss the notice.

The WinPost program is now running and its icon is displayed at the bottom of the
SoftWindows desktop.

5. Display the WinPost menu

Point to the WinPost icon in the taskbar and press the = key on the numeric keypad
or click the right mouse button. A pop-up menu appears above the taskbar.

For more information about all the commands, refer to the WinPost Manual file.

6. Create a new note

■ In the WinPost menu, choose Create a note, then Default. An empty Note
window appears.

■ Type in the information you want to remember.

The buttons along the top of the note provide useful functions. For example, the first
three are cut, copy, and paste.

Copying and pasting text and graphics in Windows 95

SoftWindows includes an Insignia utility called SmartCopy, which converts text and
graphics between the Windows and X Windows clipboards, so that you can copy or cut
and paste between X Windows and Windows 95 applications.

When you move the mouse pointer out of the SoftWindows window, the SmartCopy icon
changes to show when text or graphics is ready to paste into an X application.
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When you move the mouse pointer into the SoftWindows window, the SmartCopy icon
changes to show when text or graphics is ready to paste from an X application.

To copy text from X Windows to Windows 95

1. Choose the appropriate command in the X Windows application to copy the text
you want to transfer.

2. Move the mouse focus to SoftWindows.

SmartCopy converts the text to Windows 95 format on the Windows clipboard, and
you can use the Clipboard Viewer to view it.

3. Move the mouse pointer to position the cursor where you want to paste the text.

4. Choose Paste from the Edit menu of the Windows 95 application into which you
want to paste the text.

To copy graphics from the Unix workstation screen to Microsoft
Windows

Choose From Display from the Paste Graphics cascade menu on the Actions menu.

The cursor changes into crosshairs, allowing you to select a portion of the display which
will be copied to the Windows 95 clipboard.

To view the graphic:

1. Open the Clipboard Viewer.

Click the Start button, choose Programs, choose Access, and then choose Clipboard
Viewer.

2. Choose DIB Bitmap from the Display menu.

To paste the graphic into a Microsoft Windows application, choose Paste from the Edit
menu of the Windows application into which you want to paste the graphic.
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To copy graphics from X Windows to Windows 95

1. Choose the appropriate command in the X Windows application to copy the
graphic you want to transfer.

2. Switch to SoftWindows.

3. Choose Paste Graphics from the Action menu, and choose the From Application
option.

The graphic is converted into Windows format on the Windows clipboard.

4. Choose Paste from the Edit menu of the Windows application into which you want
to paste the graphic.

To copy text or graphics from Windows 95 to X Windows

1. Select the text or graphic you want to copy from the Windows application.

2. Choose Copy from the application’s Edit menu.

The text or graphic is put into the Windows clipboard, and you can use the
Windows Clipboard Viewer to view it.

3. Switch to the X Windows application you want to use.

SmartCopy converts the text or graphic to X Windows format in the X clipboard.

4. Choose the appropriate command to paste in the text or graphic you copied.

Printing from Windows applications

If your Unix printer is a PostScript printer, you will get the best results by printing
PostScript from Windows.

To print PostScript to the Unix printer

1. Choose Printer Ports… from the COM/LPT Ports cascade menu on the Options
menu.

2. The Printer Ports dialog box appears.

3. Choose Pipe from the LPT1: popup menu. Check that this is set to the default
setting, which sends output to the local print spooler, lp.
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4. Check the "Enable Windows PostScript Flushing" box.

5. Make sure you have Windows set up for a PostScript printer.

To set up Windows for a PostScript printer

1. Click the Start button, choose Settings, and then choose Printers to display the
Printers folder.

2. Select PostScript Printer, and choose Set As Default from the File menu.

To print from Windows to a non-PostScript printer

If your Unix printer does not support PostScript, you should set up Windows for the
printer you are using.

1. Choose Options, then COM/LPT Ports, then Printer Ports...

The Printer Ports dialog box appears.

2. Choose Pipe from the LPT1: popup menu. Check that this is set to the default setting,
which sends output to the local print spooler, lp.

3. Set Enable Windows PostScript Flushing to flush output to the pipe. See Flushing
output to a file or pipe.

4. Click the Start button, choose Settings, and then choose Printers to display the
Printers folder.

5. Select the appropriate option for your Unix printer, and choose Set As Default from
the File menu.

Installing and running Windows applications

Most Windows applications are installed using the standard Windows setup procedure.
If your Windows application is supplied on CD-ROM or 3.5-inch disks, you can install
using your workstation’s corresponding drive.



32

Chapter 3: Using Windows 95

To install a Windows application

1. Insert the application’s installation media into the workstation’s appropriate drive.

2. Click the Start button, choose Settings, and then choose  Control Panel.

3. Double-click the Add/Remove Programs icon. A dialog box appears.

4. Click Install... to start the installation.

5. The installation program locates the installer on the media you inserted.

6. Click Finish to run the installer.

7. As the installation proceeds, dialog boxes will prompt you for any information
needed for the installation.

To run a Windows application

1. Click the Start button, and then choose Programs.

2. Point to the folder containing the program, and double-click it.

Note: For certain installations it may be necessary to have the Windows 95 upgrade
CD-ROM loaded.
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4. Using MS-DOS

This chapter describes the original operating system fpr PCs, called MS-DOS, which is
available from within Windows 95. This chapter explains the basics of how MS-DOS
works and how to use it.

Running MS-DOS

To display the SoftWindows MS-DOS window

You can exit to MS-DOS from Windows 95 by choosing Shut Down..., then Restart the
computer in MS-DOS mode.

Additionally, you can open an MS-DOS window by clicking the Start button, choosing
Programs, and choosing MS-DOS Prompt.

MS-DOS basics

About the MS-DOS prompt

MS-DOS lets you give commands by typing instructions at the MS-DOS C:\> prompt.

About the screen editor

MS-DOS includes a simple screen editor which you can use to create, edit, and print plain
text files. See “Using the MS-DOS editor” for more information.

You can choose editing commands from menus and edit text using the mouse. The
MS-DOS editor is particularly useful for editing MS-DOS  batch programs such as
AUTOEXEC.BAT and other files such as CONFIG.SYS.

For more information, refer to a MS-DOS reference book, like Microsoft MS-DOS User’s
Guide.
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Using the SoftWindows MS-DOS window

To resize the SoftWindows MS-DOS window

You can resize the SoftWindows MS-DOS window to one of three alternative fixed sizes,
1.0x, 1.5x, and 2.0x, up to the size of your workstation screen. Drag the window by any
of its resize corners. When you release the mouse button the window will snap to the
closest fixed size.

Using the mouse in MS-DOS

If you have a mouse attached to your computer, it will be automatically attached when
you run Windows applications. You can also use it with MS-DOS programs that support
a Microsoft Bus mouse by using the SoftWindows Attach Mouse command.

To use the mouse in MS-DOS

Choose Attach Mouse from the Actions menu.

Alternatively, you can attach the mouse from the keyboard as follows. Hold down Ctrl
and Alt and click the middle mouse button (or both buttons on a two-button mouse).

When you attach the mouse, the workstation mouse disappears. The SoftWindows
menus will be inaccessible, and you cannot access X Windows windows belonging to
other Unix applications. The menu bar displays a message.

To restore the normal workstation mouse

Hold down Ctrl and Alt and click the middle mouse button (or both buttons on a two-
button mouse).

Using the MS-DOS editor

To run the MS-DOS editor, type EDIT filename at the prompt, where filename is the
name of the file you want to edit, or omit the filename to create a new file.
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For example, to edit the AUTOEXEC.BAT startup file type:

EDIT AUTOEXEC.BAT

The file will then be displayed in the MS-DOS editor.

To use the mouse

Choose Attach Mouse from the Actions menu.

To edit the file

1. Position the cursor using the arrow keys or by moving and clicking the mouse.

2. Type to insert text at the cursor.

To cut, copy, and paste text

1. Press and drag the mouse pointer over the text you want to cut or copy.

2. Use the Cut, Copy, Paste, and Clear functions from the MS-DOS editor’s Edit menu.

To delete text

1. Press and drag the mouse pointer over the text you want to delete.

2. Press Delete or type the text you want to replace it with.

To exit from the MS-DOS editor

1. Choose Exit from the editor’s File menu.

You can do this from the keyboard by typing Alt,F, X.

You will be prompted to save the file before exiting if you have made any changes
to it.

2. Click Yes, or press Enter, to save the changes and exit from the MS-DOS editor.
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Using MS-DOS commands

You can type MS-DOS commands at the MS-DOS prompt as you would on a real PC.

The following list gives the most useful MS-DOS commands; refer to an MS-DOS
reference guide for more detailed information.

In the syntax for each command, square brackets indicate optional arguments.

Note that MS-DOS is not case-sensitive; that means MS-DOS treats upper and lower case
characters as equivalent.

Getting help

You can display help about any command by typing:

command /?

CD

Changes the current directory.

Syntax

CD [path]directory

Example

To change your current directory to C:\LOTUS type:

CD C:\LOTUS

COPY

Copies one or more files between two directories.

Syntax

COPY [drive:][path]file [drive:][path]file
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Example

To copy a file named BUDGET.WK1 from the LOTUS directory on your C: drive to the D: drive
type:

COPY C:\LOTUS\BUDGET.WK1 D:\BUDGET.WK1

DEL

Deletes specified files.

Syntax

DEL [drive:][path]file

Example

To delete the file named \WP\REPORT.OLD on the D: drive type:

DEL D:\WP\REPORT.OLD

DELTREE

Deletes a directory and its subdirectories.

Syntax

DELTREE [drive:][path]directory

DIR

Lists the files in a directory.

Syntax

DIR [drive:][path][/W]

The /W (wide) option displays the files in columns.
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Example

To list the files on your D: drive in the WP subdirectory in wide format type:

DIR D:\WP /W

FORMAT

Formats a disk.

Syntax

FORMAT [drive:] [/option]

The options are shown in the following table:

You should format only low-density disks in the 720 Kbyte format and only high-density
disks in the 1.4 Mbyte format.

A drive set up as a SoftWindows FSA drive cannot be formatted.

HELP

Gives help about using an MS-DOS command.

Syntax

HELP [command]

where command is the long or short form of the command.

Table 4-1 Format Options

To format Give this command

3.5-inch low density FORMAT A: /F:720

3.5-inch high density FORMAT A: /F:1.44
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Example

To get help about the FORMAT command, type:

HELP FORMAT

KEYB

Selects a foreign keyboard character set.

Syntax

KEYB [xx,,[[drive:][path][file]]]

where xx is a two-letter keyboard code and file is the name of the keyboard definition file;
refer to "Setting up keyboards" in the SoftWindows95 for Unix Administrator’s Guide.

Example

To use a French keyboard with the standard definition file type:

KEYB FR

For further information on keyboards in SoftWindows, see "SGINDYUS.KBD" in
Chapter 12 of the SoftWindows95 for Unix Administrator’s Guide.

MD (MKDIR)

Makes a subdirectory.

Syntax

MD [drive:][path]directory

Example

To make a directory named PCAPPS on your D: drive, type:

MD D:\PCAPPS
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RD (RMDIR)

Removes an empty directory.

Syntax

RD [drive:][path]directory

Example

To remove the empty subdirectory named TEMP from your D: drive type:

RD D:\TEMP

TYPE

Displays the contents of a text file on the screen.

Syntax

TYPE [drive:][path]file

Example

To display the contents of the file TEXT.OUT from the WP subdirectory on your D: drive type:

TYPE D:\WP\TEXT.OUT

XCOPY

Copies files and directories, including their subdirectories.

Syntax

XCOPY [drive:][path]file [drive:][path] /S

where the /s switch ensures that all the subdirectories are also copied.
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Example

To copy all the files and directories from your C: drive to your D: drive type:

3. XCOPY C:\*.* D:\ /S

Using the special Unix/MS-DOS commands

There are several commands provided by Insignia that allow you to convert files from
Unix to DOS format and back and execute Unix commands from MS-DOS. These
commands are describe below.

DOS2UNIX

Converts an MS-DOS text file to Unix format.

Syntax

DOS2UNIX dosfile unixfile

Example

To convert README.TXT to HELP.C type:

DOS2UNIX README.TXT HELP.C

For more information refer to the SoftWindows95 for Unix Administrator’s Guide.

RUNUX.COM

Executes a Unix command from MS-DOS.

Syntax

RUNUX unixfile



42

Chapter 4: Using MS-DOS

Example

With E: configured to access the Unix directory $HOME:

RUNUX E:\scripts\my_script

For more information refer to the SoftWindows95 for Unix Administrator’s Guide.

UNIX2DOS

Converts a Unix format text file to MS-DOS format.

Syntax

UNIX2DOS unixfile dosfile

Example

To convert UNIX.C to DOS.TXT type:

UNIX2DOS UNIX.C DOS.TXT

For more information refer to the SoftWindows95 for Unix Administrator’s Guide.

Copying and pasting between MS-DOS and Unix

When SoftWindows is displaying the MS-DOS window, text can be copied from and
pasted into the SoftWindows window using the following procedures.

Note: This functionality is only available for the full screen MS-DOS window;
copy/paste does not work for MS-DOS windows within SoftWindows.

To paste text into the SoftWindows MS-DOS window

1. Select the text you want to copy by holding down the Select mouse button (left, by
default) and dragging the pointer over the text in the Unix window.

2. Lift your finger off the mouse button.
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3. Move the mouse pointer into the SoftWindows MS-DOS window and position the
cursor where you want to paste the text.

4. Click the middle mouse button.

To copy text from the SoftWindows MS-DOS window

1. Select the text you want to copy, by holding down the left mouse button and
dragging the pointer over the text in the SoftWindows MS-DOS window.

2. Lift your finger off the mouse button.

3. Move the mouse pointer into the Unix window and position the cursor where you
want to paste the text.

4. Click the middle mouse button.

The text will be typed into the Unix window at the current cursor position.

Printing from MS-DOS applications

Most MS-DOS applications give good results when set up for dot-matrix, bubble-jet, or
PostScript printers.

To print from MS-DOS to a non-PostScript printer

1. Choose Printer Ports… from the COM/LPT Ports cascade menu on the Options menu.

2. The Printer Ports dialog box appears.

3. Choose Pipe from the LPT1: popup menu. Check that this is set to the default setting,
which sends output to the local print spooler, lp.
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Figure 4-1 The Printer Ports Dialog Box with Non-PostScript Printer Setting

4. Set Enable Windows PostScript flushing.

5. Choose the appropriate command to print from your MS-DOS application.

To print to a serial printer with default settings

You can print from an LPT port to a serial printer with the following fixed
communications settings:

9600 baud, no parity, 8 data bits, 1 stop bit, XON/XOFF handshaking.

1. Connect the printer to the serial port.

2. Choose Options, COM/LPT Ports, Printer Ports…

The Printer Ports dialog box appears.

3. Choose Device from the LPT1: popup menu. By default this sends output to one of
the serial ports. You may need to change this depending on which port you are
using.
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Figure 4-2 The Printer Ports Dialog Box with Serial Printer Settings

To print to a serial printer with selectable settings

If you need to use different communications settings, set a COM port to Printer and use
the MODE command to set the communications parameters. For example, MODE
COM1:9600,N,8,1 sets 9600 baud, no parity, 8 data bits, and 1 stop bit, the default setting.
XON/XOFF handshaking is supported.

If your application can only print to an LPT port, use the MODE command to direct LPT
output to the COM port, for example, MODE LPT1:=COM1:

Include the MODE commands in your AUTOEXEC.BAT file if you want to use these settings
every time you run SoftWindows.

Installing MS-DOS applications

To install an MS-DOS application you should follow the installation instructions in the
manual supplied with the application.

MS-DOS software is typically supplied on one or more floppy disks, and to install the
program you copy the files from these disks to your PC hard disk.
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To simplify the installation process, most PC programs provide a batch file which
automatically copies the files for you. The batch file is typically called SETUP.BAT or
INSTALL.BAT, and you run it by typing SETUP or INSTALL at the MS-DOS prompt.

To install from 3.5-inch disks

The simplest way of installing PC software, if you have a floppy disk drive available, is
to install directly from 3.5-inch installation disks.

1. Make sure your floppy drive is set to the A: or B: drives. To do this:

■ Open the SoftWindows menu item Actions, and choose Activate.

■ A red checkmark should appear next to the A: or B: drive. This indicates that
the drive is active.

■ If neither the A: drive nor the B: drive is active, see "Setting up floppy disk
drives" in the SoftWindows95 for Unix Administrator’s Guide.

2. Follow the instructions supplied with the software. For example, you may be
instructed to type:

A:\SETUP

If at any stage in the installation you need to change disks, refer to Chapter 2, “To eject a
floppy disk”.

To install from 5.25-inch disks

If the software is supplied on 5.25-inch disks, in some cases you can use a PC to copy the
software onto 3.5-inch MS-DOS format disks, and then install from these. 5.25-inch
format is not supported in Silicon Graphics systems.

Installing software from a network server

Instead of installing directly from 3.5-inch disks, you can copy the software from a PC to
a directory on your workstation via a network or serial connection. To do this:
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1. Make a directory on your workstation to copy the application installer files into
(these installation files are usually called SETUP.BAT or INSTALL.BAT).

2. To make this directory available to SoftWindows, you must specify the directory as
an FSA drive. To do this, see "Setting up FSA drives" in the SoftWindows95 for Unix
Administrator’s Guide.

3. Now you can install the files from your newly set-up directory.

Note: Some installer programs assume that you are installing from floppy disk. They
may not work correctly if you copy all the files to a hard disk first, and then try installing
from the hard disk.

Where to install

The installation program will typically give you the option of where to install the files it
is copying from the installation disks.

You have the following options:

Note: Some PC application installer programs will only install onto a hard disk file
(drives C: or D:). Also, some installers will assume that drives E: to Z: are a PC network,
and install additional networking software if you specify these drives.

Table 4-2 Installing Files

Install here To do this

Drive C: or D:

SoftWindows hard disk file.

If you are sure that the SoftWindows
files you are installing will fit on your
SoftWindows hard disk file, and you do
not need to access the files using other
Unix programs.

Drive E: to Z:  SoftWindows FSA drive If you want to install into the Unix
filesystem rather than your
SoftWindows hard disk file so that you
can share data with other Unix
applications or other SoftWindows
users.
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Disk space requirements

Before installing onto the hard disk, check the disk space requirements specified in the
PC application’s manual, and verify the available hard disk space. For example, if you
are installing to drive C: type:

CHKDSK

at the MS-DOS prompt.

Note: 1048576 bytes = 1 Mbyte.

If you do not have enough space on your hard disk to install the application, refer to the
"SoftWindows95 for Unix Administrator’s Guide" for details on how to enlarge or create PC
drives.
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5. Troubleshooting

About troubleshooting

The SoftWindows troubleshooting information is divided into the following  sections:

• “Common questions” discusses commonly asked questions about using
SoftWindows

• “Common problems” discusses the most commonly encountered problems when
using SoftWindows

• “MS-DOS errors” contains details of the MS-DOS error messages, with explanations
and suggested solutions

• “SoftWindows FSA errors” contains details of the SoftWindows FSA (File Sharing
Architecture)  error messages with explanations and suggested solutions

• “SoftWindows errors” contains details of the SoftWindows FSA (File Sharing
Architecture)  error messages with explanations and suggested solutions

• “Networking errors” contains suggested solutions to problems that you may
encounter when running PC applications on your workstation with SoftWindows

Common questions

The following sections contain answers to the most commonly asked questions about
using SoftWindows.

Using floppy disks

How do I format a floppy disk?

Use the FORMAT command at the MS-DOS prompt. See “FORMAT” in Chapter 4.
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Using hard disks

How do I create a new hard disk?

Use the New Drive… function on the Disk Drives… cascade menu on the Options menu;
refer to Chapter 4, "Setting up hard disk files" in the SoftWindows95 for Unix
Administrator’s Guide.

How do I make a hard disk file larger?

Use the Modify Drive... function on the Disk Drives… cascade menu on the Options menu.
If Modify Drive returns an error, it is possible that your disk is corrupted. Try running
the DOS utility scandisk to correct the problem, and try again. Refer to Chapter 4, "Setting
up hard disk files" in the SoftWindows95 for Unix Administrator’s Guide.

How do I share hard disks?

Make the hard disk read-only; more than one user can then read data from it. To do this,
enter the following command in a Unix terminal window:

chmod 444 filename.hdf

where filename.hdf is the name of the hard disk file.

It may be useful to use the RO_DISK_PANEL_DISABLE configuration option; for more
information refer to Chapter 7, "RO_DISK_PANEL_DISABLE" in the SoftWindows95 for
Unix Administrator’s Guide.

Can I use hard disk files from other versions of SoftWindows or SoftPC?

You can use the hard disk file from other versions of SoftWindows as D:, but do not use
them as drive C: because the version of Windows and the configuration files are not
compatible. For information on upgrading your old SoftWindows hard disks, refer to
Chapter 5, "Upgrading a version 1 hard disk file" in the SoftWindows95 for Unix
Administrator’s Guide.
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Using CD-ROM

How do I set up a CD-ROM drive?

Refer to Chapter 4, "Setting up the CD-ROM" in the SoftWindows95 for Unix
Administrator’s Guide.

How do I read an MS-DOS CD-ROM?

Refer to “Using CD-ROMs” in Chapter 2.

Using memory

How do I change the memory setting for PC applications?

Use the Memory dialog box; refer to Chapter 4, "Setting up memory" in the SoftWindows95
for Unix Administrator’s Guide.

Using keyboards

How do I set up a foreign keyboard in MS-DOS?

Use the MS-DOS KEYB  command; refer to Chapter 4, "Setting up keyboards" in the
SoftWindows95 for Unix Administrator’s Guide.

How do I set up a foreign keyboard in Windows?

Use the Windows Keyboard control panel; refer to Chapter 4, "Setting up keyboards" in
the SoftWindows95 for Unix Administrator’s Guide.

Using the screen

How do I change the size of the SoftWindows screen?

When running MS-DOS, you can select between 1.0x, 1.5x, and 2.0x scales in the Display
dialog box; refer to To resize the SoftWindows MS-DOS window...
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When you are running Windows, you can specify any size, up to the full screen; refer to
the SoftWindows95 for Unix Administrator’s Guide.

Using printers

How do I set up the COM and LPT ports?

Refer to Chapter 2, “Printing, input, and output”.

How can I print from an MS-DOS application?

Refer to Chapter 4, “Printing from MS-DOS applications”.

How do I set up a printer for Windows?

Use the Windows Printers control panel; refer to Chapter 4, “Printing from MS-DOS
applications”.

Using serial devices

How do I use the serial ports with PC applications?

Refer to Chapter 2, “Serial input and output”.

Converting between MS-DOS and Unix

How do I convert text documents between DOS and Unix?

If the documents are on a SoftWindows hard disk file, you can use the MS-DOS utilities
DOS2UNIX and UNIX2DOS; refer to “DOS2UNIX” in Chapter 4, or “UNIX2DOS” in
Chapter 4.

If they are in the Unix file system, you can use the Unix utilities "dostounix" and "unixtodos"
supplied in the $SWINHOME/bin directory. See Chapter 11, "Unix utilities in the
SoftWindows95 for Unix Administrator’s Guide.
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How can I copy and paste between PC and X Windows applications?

Use the SoftWindows copy and paste facilities; refer to Chapter 4, “Copying and pasting
between MS-DOS and Unix”.

Setting Unix file access

What are Unix file access permissions?

File access permissions are used to tell a computer system who has access to files and
directories. Files and directories have a set of permissions to determine which users can
read, write, and execute the contents of a file. If a system is shared or is part of a network,
other people may need access to its files and directories.

By setting file access permissions you control who is able to read, write, and use your files
and directories.

There are four types of permissions for files and directories:

Table 5-1 Permissions for Files and Directories

Permission Symbol What it means

Read r Allows users to view or
copy a file, or list files in a
directory.

Write w Allows users to create,
edit, and delete a file. For a
directory, the write
permission allows users to
create or delete files only.
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Any of the permissions can be assigned to three categories of users:

How do I check Unix file access permissions?

You can check file access permissions using the Unix ls -l command.

In a Unix terminal window, move to the directory containing the file by typing the
command:

cd pathname

Then type:

ls -l filename

The output will be of the form:

-rwxrwxrwx 1 root 512 jun 9 09:35 filename

Execute x Allows users to run an
executable file, such as a
program or application,
and search a directory.

SUID s Runs a Unix executable as
its owner, rather than as
the user who launched it.
SoftWindows uses this to
gain access to network
devices normally
unavailable to the user.

Table 5-2 Users and Symbols for Permissions

User Symbol What it means

Owner u The creator of the file (or
directory)

Group g The other users in the
owners group

Others o All other users

Table 5-1 (continued) Permissions for Files and Directories

Permission Symbol What it means
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where the file access permissions are represented by the letters rwxrwxrwx; r is for read, w
write, and x execute. The three sets are for the Owner, Group, and Others, respectively.

How do I change Unix file access permissions?

You can change file access permissions using the Unix "chmod"command.

To change the permissions you need to be logged in as the owner or root. If necessary, ask
your system administrator to do this. Then issue the chmod command with an appropriate
parameter.

The parameter consists of u (owner), g (group), or o (other), followed by + or - to add or
remove permissions, respectively, followed by the type of access: r (read), w (write), or x
(execute).

For example, to make a file so that the Owner can read it or write to it, and the Group can
write to it, give the command:

chmod u+w+r g+w filename

For more information on file access permissions consult your Unix reference manuals.

Using Configuration

Where is my SoftWindows configuration stored?

In the .swinconfig file in your home directory; refer to Chapter 7, "SoftWindows
configuration file" in the SoftWindows95 for Unix Administrator’s Guide.

What determines the configuration of MS-DOS?

The MS-DOS files AUTOEXEC.BAT and CONFIG.SYS; refer to MS-DOS configuration, in the
SoftWindows95 for Unix Administrator’s Guide.
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Running PC Applications

How do I install PC software with SoftWindows?

Refer to “Installing MS-DOS applications” in Chapter 4.

How do I give MS-DOS commands?

Type them at the C:\> prompt; refer to “Using MS-DOS commands” in Chapter 4.

How can I edit MS-DOS files?

Use the MS-DOS editor, EDIT; refer to “Using the MS-DOS editor” in Chapter 4. In
Windows you can use the Windows Notepad text editor.

Using Windows

What Windows drivers does SoftWindows use?

When you run Windows in a window you are not using one of the emulated display
drivers (SVGA or Hercules), and the title bar changes to SoftWindows Desktop to
indicate that you are using the SoftWindows Windows display and mouse drivers. These
are called SoftWindows Display and SoftWindows Mouse.

Common problems

The following sections contain solutions to the most frequently encountered problems
when using SoftWindows.

Using the mouse

The workstation mouse pointer has disappeared

While the mouse is attached for use by MS-DOS applications it is not available to Unix
programs.
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Using printers

Printing is not working properly

If you are using the print spooler, flush the port to ensure that all the data has been sent.
Disable autoflush and flush the port manually. See “To flush output manually” in
Chapter 2.

Redirect print output to a file, then print the file outside SoftWindows; refer to
“Redirecting to a file and piping to a process” in Chapter 2.

Using FSA drives

I get an error message when I try to use an MS-DOS file on an FSA drive

Because MS-DOS was not designed to handle file ownership and permissions like the
Unix system, MS-DOS uses an assortment of standard file error messages to indicate that
you do not have permission to read, write to, or execute a given file or directory.

The following messages may indicate that you do not have access to a particular file or
directory due to the file permissions:

File creation error

File not found

Invalid directory

Invalid path (or file not found)

If one of these messages appears in MS-DOS and you are certain that the file or directory
exists, you should check the permissions and ownership using Unix.

Also note that an SUID bit with incorrect ownership will cause permission problems on
FSA drives.

Alternatively, copy the files to the hard disk C: or D: and try again.
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Using networking

Problems experienced with SoftNode generally tend to be one of two types—problems
with the ODI driver loading or configuring itself, or problems with networking
applications after the software has been loaded.

ODI driver problems

If the driver completely fails to load, it will display a message which says:

Could not find a host network card

This means that SoftNode has been unable to make contact with the networking facilities
on the host machine. This is normally due to one of two things:

• SoftWindows has lost its SUID bit. The SoftWindows executable $SWINHOME/bin/swin
needs to be installed by root, and should be owner root, mode 4755. The exact name of
the executable depends on the type of workstation you are using, but is usually
/usr/lib/SotWindows/bin/SoftWindows95.

• The network package which SoftWindows requires is not installed on the host
workstation. For more information about which software package must be installed
on each system refer to SoftWindows network devices in the SoftWindows95 for Unix
Administrator’s Guide.

If you are not sure whether these packages are installed on your system, contact your
system administrator.

If the driver loads but reports an error registering one or more of the protocols specified
in the NET.CFG file, then SoftNode probably does not support the appropriate frame type
or protocol on that version of SoftWindows.

Network software errors

If the ODI system loads successfully but the network software package you wish to use
does not function properly, then it may be that either SoftNode or the package has been
configured incorrectly. Please refer to Chapter 9, "Networking with SoftWindows" in the
SoftWindows95 for Unix Administrator’s Guide for additional troubleshooting information.
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Running PC applications

No display is visible in the SoftWindows window

An MS-DOS application may have been started with the wrong video mode. Change the
display type; refer to Chapter 4, "Setting up the display" in the SoftWindows95 for Unix
Administrator’s Guide.

Application fails to run at all or locks up SoftWindows

The application may be copy protected and installed on an FSA drive. Reinstall on the C:
or D: drives.

Alternatively, the application may require additional memory; refer to Chapter 4,
"Setting up memory" in the SoftWindows95 for Unix Administrator’s Guide.

Using Windows 95

Windows will not run

Windows needs a minimum of 4 Mbyte of memory to run, and 8 Mbyte is recommended.
Check that this has been set correctly; refer to Chapter 4, "Setting up memory" in the
SoftWindows95 for Unix Administrator’s Guide.

Windows will not run with a read-only C: drive

Temporarily make it readable and writable. Then in your AUTOEXEC.BAT file change the
line

SET TEMP=C:\DOS

to specify a writable disk. For example:

SET TEMP=H:



60

Chapter 5: Troubleshooting

MS-DOS errors

These errors appear in the SoftWindows window:

Table 5-3 Errors Appearing in the SoftWindows Window

Error Explanation Suggestion

Not ready error reading
drive A/B Abort, Retry,
Fail

Your floppy disk drive is
not attached to
SoftWindows, or the
specified drive is set to
Empty in the Open Disk
Drives dialog box, or there
is no disk in the drive.

Attach or select the floppy
disk drive, or insert a disk
and retry the command.

Invalid drive specification If you are trying to access
drive D:, there is no
SoftWindows hard disk
file selected as drive D:.

Select a file as drive D:

If you are trying to access
an FSA drive, the software
needed to access FSA
drives is not set up
correctly.

Check that CONFIG.SYS
and AUTOEXEC.BAT are
set up correctly

Non-System disk or disk
error

SoftWindows is
attempting to boot from
an MS-DOS floppy disk in
drive A: which has not
been initialized as a
startup disk.

Eject the floppy disk from
drive A:
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SoftWindows FSA errors

These errors appear in the SoftWindows window and relate to the use of FSA drives

Table 5-4 FSA-Related Errors in the SoftWindows Window

Error Explanation Suggestion

The host filesystem
directory cannot be found

The FSA directory cannot
be found.

Verify that the Unix
directory has not been
renamed, moved, or
deleted.

The host filesystem name
must be a directory

An FSA drive has been
given the name of a Unix
file.

Only Unix directories can
be specified for FSA
drives.

The host filesystem must
have read access

The FSA directory cannot
be read.

Change the Unix
directory’s access
permissions.

The x drive is not being
used

You are trying to detach a
drive with NET USE /D
which is not attached.

Check the NET USE
command argument for
drives currently
attached.

The x drive is not a
network drive

You are trying to attach a
non-network drive which
is already in use, for
example, drive C:, with a
NET USE command.

Retry the NET USE
command with the correct
drive id.

The x drive is already in
use

You are trying to attach a
network drive (id of E
onwards) with a NET USE
command, but the drive is
already in use.

Retry the NET USE
command with the correct
drive id.

Illegal drive specification The drive letter specified
in an FSADRIVE or NET
USE command is not
valid.

Check that it is a single
letter followed by a colon,
in the range E to
LASTDRIVE.
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Note: The NET USE command does not work in a DOS box.

SoftWindows errors

Errors reported by SoftWindows are numbered, and appear in an error dialog box.

For details of these errors, refer to Chapter 12, "Error messages" in the SoftWindows95 for
Unix Administrator’s Guide.

Networking errors

By default, networking errors are not displayed in an error dialog box.

Please refer to Chapter 9, "Troubleshooting" in the SoftWindows95 for Unix Administrator’s
Guide for details of how to enable network error reporting.
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Application icon

In Windows, a graphic icon that represents a running application. This icon appears only
after you start an application and reduce (minimize) it.

Application window

In Windows, the window containing the work area and menu bar for an application. The
name of the application appears at the top of the window.

AUTOEXEC.BAT

A special batch file that is executed each time the PC boots up.

Batch file

A text file, identified by a .BAT extension, containing MS-DOS commands. When the file
is run, the commands it contains are executed in sequential order as if they were typed
at the keyboard.

Boot

The PC terminology for starting up the computer.

CD-ROM

A read-only form of data storage, using standard Compact Disc media, capable of
providing over 600 Mbytes of data.

Client

A system on a network that uses services held on other remote systems.

Communication port

The name given to the interface which can be used to connect a modem. This is also
known as the serial communication port.
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COM1 to COM4

The names of the serial communication ports supported by MS-DOS.

Configuration file

A file containing information to determine which printers, disk drives, and other devices
will be available to you when you run SoftWindows.

CONFIG.SYS

A special MS-DOS text file that contains commands to configure the MS-DOS operating
system.

Control menu box

An application running in Windows has a control menu box at the top left of the
application window. This allows you to control the characteristics of the window and
switch between applications.

Copy protection

A routine embedded in commercial software that prevents users from making
unauthorized copies.

Current directory

The directory in which MS-DOS looks for files.

Current drive

The drive on which MS-DOS looks for a directory or a file.

Device

A piece of hardware, such as a printer, that performs a specific task.

Device name

The name used to refer to a device; for example, LPT1: and LPT2: are used to refer to printers.

Directory

A division or level in an hierarchical file storage system that can include files and other
directories.

Drive letter

The letter used to identify a drive; such as A:, B:, C: to Z:.
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Emulated hard drive

A file located in your Unix file system which has an MS-DOS file system layout. This
allows the file to emulate and function like a PC hard drive. In SoftWindows, drives C:
and D: are emulated hard drives.

Ethernet

A widely used network system and communications method standardized by the IEEE
802.3 committee and by ISO.

Ethernet_802.2, _II, _SNAP, and _802.3

The alternative standards that can be used on an Ethernet  cabling system.

Expanded memory

The LIM (Lotus, Intel, Microsoft) standard for increasing the amount of memory
available to PC applications beyond their original 640 Kbytes.

Extended memory

The XMS (Extended Memory System) standard for increasing the amount of memory
available to PC applications using the protected mode available on 80286, 80386, and
80486 computers.

Extension

The last part of an MS-DOS filename, which can be used to specify the type of file. It
consists of a period and up to three letters; such as .BAT.

File

A collection of data stored on a hard disk, floppy disk, tape, or CD-ROM under a single
name.

File permissions

See Permissions.

FSA

File Sharing Architecture.

FSA drive

A name for a drive that is treated by the PC as being on a different computer. FSA drives
cannot be formatted or partitioned. SoftWindows allows you to set up Unix directories
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as FSA drives.

Group

A collection of applications, accessories, or documents within the Windows Program
Manager.

Home directory

Your default Unix directory; that is, the one you use for storing personal work, files
associated with your user account, and other directories.

IPX

One of Novell’s communication protocols, Internetwork Packet Exchange. It addresses
and routes outgoing data packets across the network. IPX is a connectionless protocol.

ISO 9660 standard

The official term for the High Sierra standard format for CD-ROMs.

Microsoft mouse

A popular type of a hand-held pointing tool that can be used with MS-DOS applications
in a SoftWindows window. SoftWindows provides you with emulated support for the
Microsoft Mouse.

Modem

A device that enables a machine or terminal to establish a connection and transfer data
through telephone lines. The name derives from the techniques it uses: modulation and
demodulation.

MS-DOS

Microsoft Disk Operating System; the system software and filing system used on IBM PC
or compatible computers.

NDIS

Network Driver Interface Specification, a standard defined by Microsoft and 3Com. It is
the media- and protocol-independent driver standard used by network operating
systems such as LAN Manager.

NET.CFG

The configuration file used by all ODI drivers and protocols.
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NetWare

Novell’s operating system that runs on file servers and routers. It controls system
resources and information processing on an entire network or internetwork.

NET USE

A command used to set up Unix directories as PC drives in SoftWindows.

ODI

Open Data-link Interface, Novell’s network interface specification. ODI-compliant
protocols require an ODI driver.

ODINSUP

A Novell converter program which allows the use of NDIS client applications, such as
Microsoft LAN Manager, with ODI drivers.

Packet

A unit of information that has been formatted for transmission on a network. A packet
contains not only data but also its destination, source, and any routing information it has
collected during its transmission over a network.

Path

A sequence of directory names, separated by a backslash in MS-DOS (\) or a forward
slash in Unix (/).

PC

An abbreviation for a personal computer such as an IBM Personal Computer or
compatible.

Permissions

The name given to settings that are assigned to each file and directory to determine
which users have access to read, write, or execute its contents.

Port

The name for a serial or parallel interface on a PC. Referred to as COM or LPT ports,
respectively, by MS-DOS.

PostScript

The name of a page-description language designed by Adobe for producing typefaces
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and graphics on different printers. Applications use the PostScript language to describe
to printers how graphics and type should appear.

Printer

A device that prints data and text on paper. A local printer is the printer attached directly
to your computer or workstation. A remote printer is accessed across the network.

Printer queue

A temporary queue of jobs or files in MS-DOS waiting to be printed on a particular
printer.

Prompt

A request, displayed by the computer, that asks you to provide some information or
perform an action; for example, the MS-DOS prompt is usually C:\>.

Protocol

A set of procedural rules that permits the orderly exchange of information. These rules
govern the content, format, timing, sequencing, and error control of the messages being
exchanged.

PROTOCOL.INI

The configuration file used by all NDIS drivers and protocols.

Read permission

A file setting that allows you, members of your group, or other users to read a file.

Reboot

A procedure that restarts a computer or SoftWindows.

Root

The name of the user who can access all files without restriction. The system
administrator always has root access.

Root directory

The highest level directory in the hierarchical filing system. The root directory is
represented as / in Unix and as \ in MS-DOS.
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Serial port

The communications port, labeled COM1: to COM4:, to which you can attach a device such
as a modem.

Server

A system on a network that provides resources such as disks and printers to other
systems. See also Client.

SPX

One of Novell’s communication protocols, standing for Sequential Packet Exchange. It
creates, maintains, and terminates the connection between network devices (such as file
servers and routers). SPX is a connection-oriented protocol.

SVGA

Super Video Graphics Array, an extension of VGA.

$SWINHOME

An environment variable that points to the Unix directory containing SoftWindows; for
example, /usr/SoftWindows95.

SYSTEM.INI

A Windows initialization file that provides information about the MS-DOS environment.

System administrator

The person in charge of performing administrative tasks on a system.

TCP/IP

Transmission Control Protocol/Internet Protocol. A widely used industry standard for
connecting different types of computers. An internet is an interconnected set of
networks.

Text editor

An application used to create or change text files. The standard MS-DOS text editor is
referred to as EDIT.

Text file

Data contained in a file that you can read because it contains ordinary letters, numbers,
and punctuation marks.
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VGA

Video Graphics Array; the most widely accepted standard for PC graphics displays.

Volume

An alternative name for a hard drive.

Windows

A Microsoft user interface for PCs, which provides windows, icons, menus, and mouse
control.

WIN.INI

A Windows initialization file that allows you to customize your Windows environment.

Write enabling

A method of allowing data to be written to a disk.

Write protection

A method of preventing new data from being written to a disk and preventing any
existing data from being overwritten.
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DataComm (Comm Ports option),  22

E

ejecting a CD-ROM,  12
ejecting a floppy disk,  11
Enable Automatic Flushing option,  18
error messages, networking,  58, 62
Exit (File menu),  9
exiting from SoftWindows,  9

F

File (Printer Ports option),  19
file, outputting to,  19
file access permissions,  53

changing,  55
checking,  54

filenames in MS-DOS,  12
floppy disks

ejecting,  11
formatting,  11, 38
troubleshooting,  49

flow control,  23
flushing output,  18, 20, 21

manually,  19
Flush Ports (Actions menu),  19

A

abbreviations,  xvi
Activate (Actions menu),  16
Attach Floppy A/B (Actions menu),  11
Auto Flush… (Options menu),  18
Autoflush Delay,  18
Auto Freeze (Options menu),  8

C

CD (MS-DOS command),  36
CD-ROMs

troubleshooting,  51
CHKDSK (MS-DOS commands),  48
commands, Unix/MS-DOS,  41
Comms Ports… (Options menu),  19, 20, 22
communications settings,  21, 44
COM ports

activating/deactivating,  16
conventions,  xvi
converting MS-DOS files to Unix format,  41
copying MS-DOS files and directories,  40
copying text,  42

from the MS-DOS window,  43
Ctrl-Alt-Del restart,  8
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foreign keyboards, character set,  39
FORMAT (MS-DOS command),  38
FPU Emulation (Options menu),  16
Freeze (Actions menu),  8
freezing SoftWindows,  8
FSA drives,  12

G

glossary,  63

H

hard disk files,  4
sharing,  50
troubleshooting,  50

HELP (MS-DOS command),  38

I

indicators in status bar
A

/B
,  11

installing MS-DOS applications, from floppy disks,
46

K

KEYB (MS-DOS command),  39
keyboards

troubleshooting,  51

L

LPT ports
activating/deactivating,  16

M

memory, troubleshooting,  51
MODE (MS-DOS command),  22, 45
mouse

troubleshooting,  56
using,  25

mouse pointer, in Windows,  25
MS-DOS

running from Windows 95,  26
MS-DOS applications,  33

disk space requirements,  48
installing from an FSA drive,  46
troubleshooting,  56, 59

MS-DOS commands
DELTREE,  37

MS-DOS directories
creating,  39
listing files,  37
removing,  40

MS-DOS files
copying,  36
deleting,  37
displaying,  40

MS-DOS window,  2
copying and pasting text,  42
troubleshooting,  51

N

networking
package required,  58
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software errors,  58

O

ODI driver, troubleshooting,  58

P

parallel ports,  17
pasting graphics

to Microsoft Windows,  30
to X Windows,  30

pasting text
into the MS-DOS window,  42
to Microsoft Windows,  28

Pipe (COM/LPT ports option),  20
piping to a process,  19
ports

activating/deactivating,  16
default values,  17
options,  17

PostScript printing,  31
Printer (Printer Ports option),  44
Printer Ports… (Options menu),  19, 20, 44
printing,  17

from Windows,  30
to a serial printer,  44
to a Unix printer,  30
troubleshooting,  52, 57

R

Restart… (Actions menu),  8
restarting SoftWindows,  8
running SoftWindows

to display the Windows desktop,  7

S

serial input and output,  21
serial ports,  17

emulation,  23
troubleshooting,  52

serial printer
printing to,  44

SmartCopy icon,  28
SoftWindows Display driver,  56
SoftWindows Mouse driver,  56
SoftWin.tmp file,  20
Special Unix/MS-DOS commands

DOS2UNIX,  41
RUNUX.COM,  41

special Unix/Ms-DOS commands,  41
$SWIN2HOME,  69

T

text files, converting to MS-DOS format,  42
troubleshooting,  49

CD-ROM,  51
converting between MS-DOS and Unix,  52
floppy disks,  49
hard disks,  50
keyboards,  51
memory,  51
mouse,  56
printers,  52, 57
running PC applications,  56, 59
screen,  51
serial devices,  52
setting up SoftWindows,  55
Windows,  56, 59

TurboStart,  2
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U

UNIX2DOS (Special Unix/MS-DOS command),  42
Unix commands, executing from MS-DOS,  41
Unix filenames, conversion for MS-DOS,  13

W

Windows
drivers,  56
printing,  31
running with a read-only C

drive,  59
troubleshooting,  56, 59
using,  25

Windows 95
exiting,  26
exiting to MS-DOS,  26

Windows applications
installing,  32
running,  32

Windows desktop,  2
resizing,  7

WinPost,  26
running,  28

X

XCOPY (MS-DOS command),  40


